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Complete teacher’s manual for Open office writer 3 Class 1 

 Summaries 

 

 What is a ‘Standard toolbar’? 

 Why we use ‘Standard toolbar’? 

 How to take a new page by using ‘Standard toolbar’? 

 How to open any file with help of ‘Standard toolbar’? 

 How to convert text document file into PDF file? 

 How to insert table with help of ‘Standard toolbar? 

 Why we use ‘Spelling and Grammar’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 How to hide and unhide ‘Formatting bar’? 

 Why we use ‘Decrease indent and Increase indent’ 

 

Now let’s start video. 

 

1. To stop video time at 59 seconds in VLC Media Player. 

 
Stop video here and ask why ‘Default formatting’ is used? 

Just listen to the answers and play the video again for the correct answer. 

 

2. To stop video time at 1 minute 20 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why the ‘Split cell’ is used? 

Just listen to the answers and play the video again for the correct answer. 

 

3. To stop video time at 1 minute 38 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why ‘Find and replace’ option is used? 

Just listen to the answers and play the video again for the correct answer. 

 

4. To stop video time at 1 minute 55 seconds in VLC Media Player. 

 
Stop video here and ask why the ‘Change case’ option is used? 

Just listen to the answers and play the video again for the correct answer. 
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5. To stop video time at 2 minute 12 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why ‘Standard toolbar’ is used? 

Just listen to the answers and play the video again for the correct answer. 

 

6. To stop video time at 2 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is ‘Hyperlink’ and how to open 

‘Hyperlink’ file? 

Just listen to the answers and play the video again for the correct answer. 

 

7. To stop video time at 3 minute 55 seconds in VLC Media Player. 
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Stop video here and ask what will we learn today? And also ask to type the 

given paragraph which is shown in video. 

Just listen to the answers and play the video again for the correct answer. 

 

 

 

 

 

 

 

 

 

8. To stop video time at 4 minute 05 seconds in VLC Media Player. 

 
Stop video here and ask students to do some formatting on the paragraph and 

then play the video again. 

 

9. To stop video time at 4 minute 17 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what is ‘Standard toolbar’? 

Just listen to the answers and play the video again for the correct answer. 

 

10. To stop video time at 4 minute 38 seconds in VLC Media Player. 

 
Stop video here and ask where is the ‘Standard toolbar? 

Just listen to the answers and play the video again for the correct answer. 

 

11. To stop video time at 5 minute 08 seconds in VLC Media Player. 

 
Stop video here and ask students to save their file with help of ‘Standard toolbar 

option. 
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12. To stop video time at 6 minute 45 seconds in VLC Media Player. 

Stop video here and check whether they’ve saved their file or not and then play 

the video again. 

 

13. To stop video time at 7 minute 00 seconds in VLC Media Player. 

 
Stop video here and ask students to take a new page with help of ‘standard 

toolbar’ and then play the video again. 

 

14. To stop video time at 7 minute 58 seconds in VLC Media Player. 

Stop video here and check whether they’ve taken a new page or not and then 

play the video again. 

 

 

 

 

 

 

15. To stop video time at 8 minute 13 seconds in VLC Media Player. 

 



   

9 
 

Stop video here and ask if they can tell what happens by using ‘Document as 

email’? 

Just listen to the answers and play the video again for the correct answer. 

 

16. To stop video time at 9 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Document as email’ option as 

shown in the video and then play the video again. 

   

17. To stop video time at 10 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Send’ button and then play the 

video again. 

 

18. To stop video time at 10 minute 41 seconds in VLC Media Player. 

 
Stop video here and ask what happens by using ‘Open’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

 

 

 

 

19. To stop video time at 11 minute 01 seconds in VLC Media Player. 



   

10 
 

 
Stop video here and ask students to open any saved file and then play the video 

again. 

 

20. To stop video time at 11 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Open’ option as shown in the 

video and then play the video again. 

 

21. To stop video time at 12 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to search their file as shown in the video and 

click on the open option and then play the video again. 

 

22. To stop video time at 12 minute 45 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘Export as pdf”? 

Just listen to the answers and play the video again for the correct answer. 
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23. To stop video time at 13 minute 09 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is full form of PDF? 

Just listen to the answers and play the video again for the correct answer. 

 

24. To stop video time at 13 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to click on shortcut option of Export as PDF in 

standard toolbar and then play the video again. 

 

25. To stop video time at 14 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to type their name and select any location and 

then click on the save option. 

 

26. To stop video time at 14 minute 47 seconds in VLC Media Player. 

Stop video here check whether students have converted their file into PDF or 

not then play the video again. 

 

27. To stop video time at 15 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to open pdf file and then play the video again. 

 

28. To stop video time at 15 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to do page preview and then play the video 

again. 

 

29. To stop video time at 17 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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30. To stop video time at 17 minute 36 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is ‘Spelling and Grammar’? 

Just listen to the answers and play the video again for the correct answer. 

 

31. To stop video time at 19minute 17 seconds in VLC Media Player. 

Stop video here and ask students to type given word as shown in video and then 

play the video again. 

 

32. To stop video time at 20 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

33. To stop video time at 21 minute 13seconds in VLC Media Player. 

 
Stop video here and ask if they know where these options are located in 

standard tool bar and then play the video again. 
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34. To stop video time at 22 minute 25seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

 

35. To stop video time at 22 minute 55 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

36. To stop video time at 24 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to do cut the paragraph as shown in the video 

and then play the video again. 

 

37. To stop video time at 24 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to take the new page and paste the paragraph 

on the new page as shown in the video again. 

 

38. To stop video time at 25 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do the formatting as shown in the video and 

then play the video again. 

 

39. To stop video time at 27 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to do ‘Undo’ and ‘Redo and then play the play 

video again. 

 

40. To stop video time at 27 minute 27 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Format paintbrush’? 
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Just listen to the answers and play the video again for the correct answer. 

 

41. To stop video time at 27 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to use format paintbrush as shown in the video 

and then play the video again. 

 

 

42. To stop video time at 29 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

43. To stop video time at 30 minute 59 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and play the video again. 

 

44. To stop video time at 31 minute 08 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘hyperlink’? 

Just listen to the answers and play the video again for the correct answer. 

 

45. To stop video time at 33 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to insert hyperlink and then play the video 

again. 

 

46. To stop video time at 34 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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47. To stop video time at 31 minute 56 seconds in VLC Media Player. 

Stop video here and ask how to lock unlock the ‘Standard toolbar’? 

Just listen to the answers and play the video again for the correct answer. 

 

48. To stop video time at 35 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to lock and unlock the standard toolbar as 

shown in the video. 

 

 

49. To stop video time at 36 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to lock and unlock the ‘Formatting toolbar as 

shown in the video. 

Now just check and then play the video again. 

 

50. To stop video time at 37 minute 03 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens by ‘Decrease indent and 

Increase indent’? 

Just listen to the answers and play the video again for the correct answer. 

 

51. To stop video time at 39 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to do ‘Decrease indent and Increase indent as 

shown in the video and then play the video again. 

 

52. To stop video time at 36 minute 38 seconds in VLC Media Player. 
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Stop video here and ask students to close their file and shutdown the computer. 
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Complete teacher’s manual for Open office writer 3 Class 2 
Summaries 

 

 What is a ‘Standard toolbar’? 

 Why we use ‘Standard toolbar’? 

 How to take new page by using ‘Standard toolbar’? 

 How to open any file with help of ‘Standard toolbar’? 

 How to convert text document file into PDF file? 

 How to insert table with help of ‘Standard toolbar? 

 Why we use ‘Spelling and Grammar’ option?  

 How to hide and unhide ‘Standard toolbar’? 

 How to hide and unhide ‘Formatting bar’? 

 Why we use ‘Decrease indent and Increase indent’ 

 

Now let’s start video. 

 

53. To stop video time at 36 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is difference between ‘Font color’ 

and ‘Highlighting color’? 

Just listen to the answers and play the video again for the correct answer. 
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54. To stop video time at 01 minute 11 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is the menus option and why we use 

it? 

Just listen to the answers and play the video again for the correct answer. 

 

55. To stop video time at 01 minute 49 seconds in VLC Media Player. 

 
Stop video here and ask which is the ‘Quick start window’ in open office? 

Just listen to the answers and play the video again for the correct answer. 

 

56. To stop video time at 02 minute 14 seconds in VLC Media Player. 
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Stop video here and ask which shortcut command is used to open ‘Quick start 

window’? 

Just listen to the answers and play the video again for the correct answer. 

 

57. To stop video time at 02 minute 39 seconds in VLC Media Player. 

 
Stop video here and ask if they know how to convert any document into pdf 

format? 

Just listen to the answers and play the video again for the correct answer. 

 

58. To stop video time at 2 minute 56 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use ‘Hyperlink’? 

Just listen to the answers and play the video again for the correct answer. 

 

59. To stop video time at 03 minute 18 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file and then play the video 

again. 

 

60. To stop video time at 03 minute 39 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given paragraph and then apply 

some formatting on it and then play the video again. 

 

61. To stop video time at 04 minute 01 seconds in VLC Media Player. 

Stop video here and ask students to hide some options such as ‘Save’, ‘Open’, 

‘New’, and ‘Export as PDF and then play the video again. 

 

62. To stop video time at 05 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 
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63. To stop video time at 05 minute 47 seconds in VLC Media Player. 

 
Stop video here and ask students to show those options which they had hidden 

and then play the video again. 

 

64. To stop video time at 07 minute 01 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

65. To stop video time at 07 minute 10 seconds in VLC Media Player. 

 
Stop video here and ask students to save the file and then play the video again. 

 

66. To stop video time at 07 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

67. To stop video time at 08 minute 38 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 
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68. To stop video time at 08 minute 51 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Hyperlink’ and then play the 

video again. 

 

69. To stop video time at 09 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Hyperlink’ option of the 

‘Standard toolbar’ as shown in the video and then play the video again. 

 

70. To stop video time at 11 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

71. To stop video time at 11 minute 25 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Document as Email ‘and 

then play the video again. 

 

72. To stop video time at 11 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Documents as email’ of the 

‘Standard toolbar’ as shown in the video and then play the video again. 
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73. To stop video time at 13 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Note:-1  Just tell the students that there is no need to click on ‘Send’ since 

internet connection and outlook is required to send email. 

 

74. To stop video time at 13 minute 56 seconds in VLC Media Player. 

 
Stop video here and ask students to convert their file into pdf and then play the 

video again. 

  

75. To stop video time at 15 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have converted their file into pdf or not then play 

the video again. 

 

76. To stop video time at 15 minute 30 seconds in VLC Media Player. 

 
Stop video here and ask students to lock the ‘Standard toolbar’ and then play the 

video again. 
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77. To stop video time at 17 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

78. To stop video time at 17 minute 29 seconds in VLC Media Player. 

 
Stop video here and ask students to bring the toolbar at different position and 

then play the video again. 

 

79. To stop video time at 18 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to change the place of ‘Standard toolbar as 

shown in the video and then play the video again. 

 

80. To stop video time at 18 minute 57 seconds in VLC Media Player. 

 
Stop video here and ask students to use the ‘Spelling and Grammar’ option and 

also ask them to type given line as shown in the video and then play the video 

again. 

 

81. To stop video time at 20 minute 26 seconds in VLC Media Player. 
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Stop video here and ask students to type a line as shown in the video and then 

play the video again. 

  

82. To stop video time at 21 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have corrected wrong words or not and then play 

the video again. 

 

83. To stop video time at 22 minute 01 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Copy’, ‘Cut’ and ‘Paste’ 

option and then play the video again. 

 

84. To stop video time at 23 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to ‘Copy’ and ‘Paste’ as shown in the video 

and then play the video again. 

85. To stop video time at 23 minute 19 seconds in VLC Media Player. 

 
Stop video here and ask students to do ‘Undo’ and then play the video again. 

 

86. To stop video time at 23 minute 31 seconds in VLC Media Player. 
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Stop video here and ask students to divide the paragraph in two parts and play 

the video again. 

 

87. To stop video time at 23 minute 45 seconds in VLC Media Player. 

 
Stop video here and ask  them to change formatting of first paragraph,  then ask 

the students to do same formatting on second paragraph as in first one with the 

help of ‘Format paintbrush tool’ as shown in video and then play the video 

again. 

 
88. To stop video time at 24 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

89. To stop video time at 25 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

90. To stop video time at 25 minute 51 seconds in VLC Media Player. 
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Stop video here and ask students to practice ‘Increase indent’ and ‘Decrease 

indent’ and then play the video again. 

 

91. To stop video time at 27 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

92. To stop video time at 27 minute 27 seconds in VLC Media Player. 

 
Stop video here and ask how to customize ‘Standard toolbar and ‘Formatting 

toolbar’? 

Just listen to the answers and play the video again for the correct answer. 

 

93. To stop video time at 27 minute 32 seconds in VLC Media Player. 
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Stop video here and ask students if they can tell how these toolbar can be 

customized? 

Just listen to the answers and play the video again for the correct answer. 

 

94. To stop video time at 31 minute 59 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

95. To stop video time at 32 minute 07 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shutdown the computer. 
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Complete teacher’s manual for Open office writer 3 Class 3 

 Summaries 

 

 What is ‘Hyperlink’? 

 Why we use ‘Zoom’ option? 

 How to send document to another user? 

 Why we use ‘Send’ option? 

 Why we use ‘Find & replace’? 

 Why we use ‘Property’ option? 

 Why we use the ‘Printing setting’?  

 Why we use ‘Template’’? 

 Why we use ‘Printer setting’? 

 Why we use ‘Navigator’ option? 

 

Now let’s start video. 

 

1. To stop video time at 34 seconds in VLC Media Player. 

 
Stop video here and ask if they know how many file can link to the page by 

using ‘Hyperlink’? 

Just listen to the answers and play the video again for the correct answer. 

 

2. To stop video time at 44 seconds in VLC Media Player. 
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Stop video here and ask if they can give a name in place of the ‘Hyperlink’?  

Just listen to the answers and play the video again for the correct answer. 

 

3. To stop video time at 1 minute 05 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell how will they show the hidden option of 

the formatting toolbar?  

Just listen to the answers and play the video again for the correct answer. 

 

4. To stop video time at 1 minute 38 seconds in VLC Media Player. 

 
Stop video here and ask if they can convert more than one page into pdf format? 
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Just listen to the answers and play the video again for the correct answer. 

5. To stop video time at 1 minute 57 seconds in VLC Media Player. 

 
Stop video here and ask students to open ‘Writer’ page and then play the video 

again. 

 

6. To stop video time at 2 minute 30 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell where is the ‘Table’ option in the 

‘Standard toolbar’? 

Just listen to the answers and play the video again for the correct answer. 

 

7. To stop video time at 2 minute 53 seconds in VLC Media Player. 
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Stop video here and ask students to draw the table. 

Now just check whether they have drawn the table or not and then play the 

video again. 

 

8. To stop video time at 3 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to draw a table as shown in the video and then 

play the video again. 

 

9. To stop video time at 4 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to type name in the first row of the table as 

shown in the video  

10. To stop video time at 5 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

11. To stop video time at 5 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have done the typing or not and then play the 

video again. 

 

12. To stop video time at 5 minute 44 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what happens with ‘Find and Replace’ 

option? 

 

13. To stop video time at 7 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to search ‘Rohan’ in the table with help of the 

‘Find and Replace’ option as shown in the video and then play the video again.  

 

14. To stop video time at 7 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to replace ‘Rohan’ word with ‘Sameer’ as 

shown in the video and then play the video again. 

 

15. To stop video time at 9 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

16. To stop video time at 11 minute 25 seconds in VLC Media Player. 

Stop video here and ask students do as shown in the video. 

Now just check whether they have done practice of ‘Find and replace’ or not 

and then play the video again. 

 

17. To stop video time at 11 minute 37 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use Navigator option? 

Just listen to the answers and play the video again for the correct answer. 

 

18. To stop video time at 12 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to click on the Navigator option of the 

‘Standard toolbar’ as shown in the video and then play the video again. 

 

19. To stop video time at 13 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to insert a picture as shown in the video and 

then play the video again. 

 

20. To stop video time at 15 minute 01 seconds in VLC Media Player. 

Stop video here and ask students to insert a ‘Hyperlink’ as shown in the video 

and then play the video again. 

 

21. To stop video time at 15 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Navigator’ option or not and then play 

the video again. 

 

22. To stop video time at 16 minute 16 seconds in VLC Media Player. 
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Stop video here and ask students to insert any object/picture with help of the 

‘Gallery’ option and then play the video again. 

 

23. To stop video time at 17 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Gallery’ option as shown in the 

video and then play the video again. 

 

24. To stop video time at 18 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to insert the object as shown in the video. 

Now just check whether they have inserted the picture or not and then play the 

video again. 

 

25. To stop video time at 18 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Non printing 

character option? 

Just listen to the answers and play the video again for the correct answer. 

 

26. To stop video time at 19 minute 35 seconds in VLC Media Player. 
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Stop video here and ask them to click on the ‘Non-printing character’ as shown 

in the video and then play the video again. 

 

27.  To stop video time at 20 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

28. To stop video time at 21 minute 00 seconds in VLC Media Player. 

 
Stop video here and ask students to change the size of the page with help of 

Zoom option and then play the video again. 

 

29. To stop video time at 22 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

30. To stop video time at 24 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced the ‘Zoom’ option or not and then 

play the video again. 

 

31. To stop video time at 24 minute 05 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use ‘Send’ option? 

 Just listen to the answers and play the video again for the correct answer. 

 

32. To stop video time at 26 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File menu’ and then click on 

the ‘Send’ option as shown in the video and then play the video again. 

 

33. To stop video time at 27 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

34. To stop video time at 29 minute 58 seconds in VLC Media Player. 

Stop video here and ask students to attach the pdf file as shown in the video and 

then play the video again. 

 

35. To stop video time at 31 minute 01 seconds in VLC Media Player. 

Stop video here and ask students do as shown in the video. 

Now just check whether they have used the ‘Send’ option or not then play the 

video again. 

 

36. To stop video time at 31 minute 11 seconds in VLC Media Player. 
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Stop video here and ask if they know what happens with the ‘Property option? 

Just listen to the answers and play the video again for the correct answer. 

 

37. To stop video time at 32 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File’ menu and then click on 

the ‘Property’ option and then play the video again. 

 

38. To stop video time at 32 minute 20 seconds in VLC Media Player. 

Stop video here and ask them to save the file as shown in the video and then 

play the video again. 

 

39. To stop video time at 35 minute 55 seconds in VLC Media Player. 

Stop video here and ask them to do as shown in the video and then play the 

video again. 

 

40. To stop video time at 38 minute 20 seconds in VLC Media Player. 

Stop video here and ask them to do as shown in the video. 

Now just check whether they have practiced the ‘Property’ option or not then 

play the video again. 

 

41. To stop video time at 38 minute 39 seconds in VLC Media Player. 
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Stop video here and ask what happens with ‘Printing setting’? 

Just listen to the answers and play the video again for the correct answer. 

 

42. To stop video time at 39 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File’ menu and then click on 

the ‘Printer setting’ option and then play the video again. 

 

43. To stop video time at 42 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to check printer setting option as shown in the 

video and then play the video again. 

 

44. To stop video time at 44 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

45. To stop video time at 47 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have done practicing of ‘Printer setting’ or not and 

then play the video again. 

 

46. To stop video time at 47 minute 06 seconds in VLC Media Player. 
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Stop video here and ask if they know what happens with’ Templates’? 

Just listen to the answers and play the video again for the correct answer. 

 

47. To stop video time at 49 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to click on the file menu and then click on the 

‘Templates’ and after that give the template name as shown in the video and 

then play the video again. 

 

48. To stop video time at 49 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to click again on the file option and select 

‘Organize’ option and then play the video again. 

 

49. To stop video time at 50 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to save the ‘Template’ as shown in the video 

and then play the video again. 

 

50. To stop video time at 51 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have made the ‘Template’ or not and then play the 

video again. 

 

51.  To stop video time at 36 minute 38 seconds in VLC Media Player. 
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Stop video here and ask students to close their file and shutdown the computer. 
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Complete teacher’s manual for Open office writer 3 Class 4 

Summaries 

 

 Why we use preview in web browser? 

 How to draw Table? 

 How to send your writer document to the other user? 

 Why we use properties option? 

 How send document in a pdf format? 

 How to connect your computer through Printer? 

 How to set your printer? 

 Why we use Templates? 

 How to use Find and replace option? 

 How to create table with help of standard option? 

Now let’s start video. 

 

52. To stop video time at 41 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Table’ option? 

Just listen to the answers and play the video again for the correct answer. 

53. To stop video time at 1 minute 03 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘Find and replace’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

54. To stop video time at 1 minute 35 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Navigator’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

55. To stop video time at 2 minute 11 seconds in VLC Media Player. 

 
Stop video here and ask if they know how to remove Non-Printing Characters? 

Just listen to the answers and play the video again for the correct answer. 

56. To stop video time at 2 minute 33 seconds in VLC Media Player. 
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Stop video here and ask them if they know what they need to do for seeing their 

page in web page? 

Just listen to the answers and play the video again for the correct answer. 

 

57. To stop video time at 2 minute 51 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file and then play the video 

again. 

58. To stop video time at 3 minute 07 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is a ‘Table’? 

Just listen to the answers and play the video again for the correct answer. 
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59. To stop video time at 3 minute 25 seconds in VLC Media Player. 

 
Stop video here and ask students to draw table and then play the video again. 

 

60. To stop video time at 4 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to draw a table and then play the video again. 

 

61. To stop video time at 5 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to type as shown in the video and then play the 

video again. 

 

62. To stop video time at 6 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

63. To stop video time at 7 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have drawn table or not then play the video again. 

 

64. To stop video time at 7 minute 53 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Find and replace’ option and 

then play the video again. 

 

65. To stop video time at 8 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Find and replace as shown in 

the video and then play the video again.  

 

 

 

66. To stop video time at 10 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to replace the number as shown in the video 

and then play the video again. 

 

67. To stop video time at 11 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

68. To stop video time at 11 minute 29 seconds in VLC Media Player. 

 
Stop video here and ask students to insert any object and cut it and paste that 

object on other place then play the video again. 

 

69. To stop video time at 12 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Gallery’ option as shown in the 

video and then play the video again.  

 

70. To stop video time at 13 minute 29 seconds in VLC Media Player. 



   

47 
 

Stop video here and ask students to insert object as shown in the video and then 

play the video again. 

 

71. To stop video time at 14 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

72. To stop video time at 16 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check then play the video again. 

73. To stop video time at 16 minute 38 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Non-Printing characters’ and 

then play the video again.  

 

74. To stop video time at 18 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check then play the video again. 

 

75. To stop video time at 18 minute 48 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Zoom’ option and then play 

the video again. 

 

76. To stop video time at 19 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to do 400% Zoom of the page and then bring 

into 50% and then play video again. 

 

77. To stop video time at 19 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Zoom’ option and then play 

the video again. 

78. To stop video time at 20 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to do 400% zoom of the page as shown in the 

video and then play the video again. 

 

79. To stop video time at 21 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do 50% zoom of the page as shown in the 

video and then play the video again. 

  

80. To stop video time at 21 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do normal size of the page as shown in the 

video. 

Now just check then play the video again. 

 

81. To stop video time at 22 minute 06 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Send’ option and file should 

be in pdf format and then play the video again.  
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82. To stop video time at 22 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘File’ menu and click on ‘Send’ 

option after that select ‘email as pdf’ as shown in the video and then play the 

video again. 

 

83. To stop video time at 23 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check then play the video again. 

 

 

84. To stop video time at 23 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Template’ option and then 

play the video again. 

 

85. To stop video time at 24 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘File menu and then click on 

‘Template’ option and select ‘Save’ option and then play the video again. 

 

86. To stop video time at 26 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to save the ‘Templates’ shown in the video and 

then play the video again. 

 

87. To stop video time at 26 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have made the ‘Templates or not and then play the 

video again. 
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88. To stop video time at 26 minute 54 seconds in VLC Media Player. 

  
Stop video here and ask students to do practice of Preview in web browser and 

then play the video again. 

 

89. To stop video time at 28 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check, and then play the video again.  

 

90. To stop video time at 26 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Printer setting’ and then play 

the video again. 

 

91. To stop video time at 28 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘File menu and then click on 

‘Printer setting’ and then play the video again. 

 

92. To stop video time at 29 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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93. To stop video time at 31 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

94. To stop video time at 33 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check, whether they have practiced the ‘Printer setting’ option or not 

then play the video again. 

95. To stop video time at 33 minute 52 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shutdown their 

computer. 
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Complete teacher’s manual for Open office writer 3 Class 5 

Summaries 

 

 What is Paste special? 

 Types of selection mode? 

 About block area and standard area? 

 Why we use ‘Auto text’? 

 About ‘Change option’. 

 About ‘Field name. 

 About Field shading. 

 Why we use Navigator? 

 How to use Find and replace option? 

 

Now let’s start video. 

 

96. To stop video time at 25 seconds in VLC Media Player. 

 
Stop video here and ask students if they remember what they had learnt in the 

previous class? 

Just listen to the answers and play the video again for the correct answer. 

97. To stop video time at 40 seconds in VLC Media Player. 
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Stop video here and ask students, how would they open writer file using 

shortcut option? 

Just listen to the answers and play the video again for the correct answer. 

 

98. To stop video time at 1 minute 09 seconds in VLC Media Player. 

Stop video here and ask how to hide ‘Standard toolbar’? 

Just listen to the answers and play the video again for the correct answer. 

 

99. To stop video time at 1 minute 47 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘Find and replace’? 

Just listen to the answers and play the video again for the correct answer. 

 

100. To stop video time at 2 minute 37 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use ‘Match case’ in ‘Find and 

replace? 

Just listen to the answers and play the video again for the correct answer. 

 

101. To stop video time at 3 minute 00 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Whole words’ in ‘Find and 

replace? 

Just listen to the answers and play the video again for the correct answer. 

 

102. To stop video time at 3 minute 22 seconds in VLC Media Player. 
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Stop video here and ask if they know what is ‘Navigator’? 

Just listen to the answers and play the video again for the correct answer. 

 

103. To stop video time at 4 minute 03 seconds in VLC Media Player. 

Stop video here and ask students to open the writer file as shown in the video 

and then play the video again. 

 

104. To stop video time at 4 minute 52 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given paragraph. 

Now just check whether they have typed out the paragraph or not and then play 

the video again. 

 

105. To stop video time at 5 minute 05 seconds in VLC Media Player. 

  
Stop video here and ask if they know why we use ‘Paste special? 

Just listen to the answers and play the video again for the correct answer. 

 

106. To stop video time at 6 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to do formatting on the line and then copy that 

line as shown in the video and then play the video again. 
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107. To stop video time at 7 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to paste the line as shown in the video and then 

play the video again. 

 

 

 

108. To stop video time at 7 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to copy the line again as shown in the video 

and then play the video again. 

 

109. To stop video time at 8 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have pasted formatted line or not and then play the 

video again. 

 

110. To stop video time at 8 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Selection mode’? 

Just listen to the answers and play the video again for the correct answer. 

 

111. To stop video time at 10 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have done practice of ‘Selection mode’ or not and 

then play the video again. 

 
112. To stop video time at 10 minute 43 seconds in VLC Media Player. 
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Stop video here and ask if they know what happens with ‘Change option’? 

Just listen to the answers and play the video again for the correct answer. 

 

113. To stop video time at 11 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Edit menu’ and then ask to select 

‘Record’ option and then play the video again. 

 

114. To stop video time at 13 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

115. To stop video time at 15 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have done the practice of ‘Change’ option or not 

and then play the video again. 

 
116. To stop video time at 15 minute 46 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘Auto text’? 

Just listen to the answers and play the video again for the correct answer. 
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117. To stop video time at 16 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to select the given paragraph as shown in the 

video and then play the video again. 

 

118. To stop video time at 17 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

119. To stop video time at 17 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to type shortcut word which they’ve typed and 

then ask to press ‘F3’ command as shown in the video and then play the video 

again. 

 

120. To stop video time at 18 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used the ‘Auto text’ option or not then play 

the video again. 

 
121. To stop video time at 19 minute 06 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Field name’? 

Just listen to the answers and play the video again for the correct answer.  

 

122. To stop video time at 20 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to insert the ‘date and time’ as shown in the 

video and then play the video again. 

 

123. To stop video time at 20 minute 54 seconds in VLC Media Player. 
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Stop video here and ask students to click on the ‘View menu’ and then activate 

the ‘Field name’ as shown in the video and then play the video again. 

 
124. To stop video time at 21 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Just check and then play the video again. 

 
 

125. To stop video time at 23 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to hide or show the ‘Field shading’ and then 

play the video again. 

 
126. To stop video time at 23 minute 33 seconds in VLC Media Player. 

  
Stop video here and ask if they can tell what is ‘Side bar’ and why we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

127. To stop video time at 25 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to hide or show the ‘Side bar’ and then play 

the video again. 

 

128. To stop video time at 25 minute 30 seconds in VLC Media Player. 
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Stop video here and ask students to close their file and shutdown the computer. 
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Complete teacher’s manual for Open office writer 3 Class 6 

Summaries 

 

 What is Paste special? 

 Types of selection mode? 

 About block area and standard area? 

 Why we use ‘Auto text’? 

 About ‘Change option’. 

 About ‘Field name. 

 About Field shading. 

 Why we use Navigator? 

 How to use Find and replace option? 

 

Now let’s start video. 

129. To stop video time at 42 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is the difference between ‘Block area 

and Standard area? 

Just listen to the answers and play the video again for the correct answer. 

130. To stop video time at 1 minute 08 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what happens with ‘Auto text’? 
Just listen to the answers and play the video again for the correct answer. 

 

131. To stop video time at 1 minute 37 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Paste special’? 

Just listen to the answers and play the video again for the correct answer.  

 

132. To stop video time at 1 minute 53 seconds in VLC Media Player. 

 
Stop video here and ask do they know why we use ‘Change option’? 

Just listen to the answers and play the video again for the correct answer. 

133. To stop video time at 2 minute 18 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘Field name’? 

Just listen to the answers and play the video again for the correct answer. 

 

134. To stop video time at 2 minute 49 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Field shading’? 

Just listen to the answers and play the video again for the correct answer. 

 

135. To stop video time at 3 minute 10 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file and then play the video 

again. 



   

64 
 

136. To stop video time at 3 minute 20 seconds in VLC Media Player. 

 
Stop video here and check whether they have opened writer file or not and then 

play the video again. 

 

137. To stop video time at 3 minute 28 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given paragraph which is shown in 

the video. 

Now just check whether they have typed the paragraph or not and then play the 

video again. 

 

138. To stop video time at 4 minute 03 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Font color’ and also ask to 

make the  paragraph bold and underline and then play the video again. 

 

139. To stop video time at 4 minute 08 seconds in VLC Media Player. 

Stop video here and check whether they have done the formatting or not and 

then play the video again. 

 

 

140. To stop video time at 4 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to use the paste special and copy the line and 

paste it on the new page and then play the video again. 

 

141. To stop video time at 5 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to select the line and copy it as shown in the 

video and then play the video again. 

 

142. To stop video time at 6 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have copy and paste or not and then play the video 

again. 

 

143. To stop video time at 6 minute 40 seconds in VLC Media Player. 
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Stop video here and ask students to use the ‘Auto text’ option and also ask to 

create shortcut and then play the video again. 

 

144. To stop video time at 9 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to take new page and type some lines as shown 

in the video and then play the video again. 

 

145. To stop video time at 9 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph and click on the ‘Edit 

menu’ and then select the ‘Auto text option as shown in the video and then play 

the video again. 

 

 

146. To stop video time at 10 minute03 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

147. To stop video time at 10 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have done used ‘Auto text’ option or not and then 

play the video again. 

 

148. To stop video time at 10 minute 43 seconds in VLC Media Player. 
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Stop video here and ask if they known what happens with ‘Change case’? 

 Just listen to the answers and play the video again for the correct answer. 

 

149. To stop video time at 10 minute 35 seconds in VLC Media Player. 

 
Stop video here and ask students to use the ‘Change’ option and then play the 

video again. 

 

150. To stop video time at 11 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Edit’ menu and then click on 

the ‘Change’ option and then select the ‘Record’ option as shown in the video 

and then play the video again. 

  

151. To stop video time at 12 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

152. To stop video time at 13 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 
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Just check whether they have used the ‘change’ option or not and then play the 

video again. 

 
153. To stop video time at 13 minute 24 seconds in VLC Media Player. 

 
Stop video here and ask students if they know how will they remove the ‘Field 

name’ and ‘filed shading? 

Just listen to the answers and play the video again for the correct answer. 

 
154. To stop video time at 14 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to insert ‘Time, Date and Page number’ as 

shown in the video and then play the video again. 

 

155.  To stop video time at 14 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘View menu’ and then select 

‘Filed name’ as shown in the video and then play the video again. 

 
156. To stop video time at 15 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Field name’ and ‘Field shading’ or not 

and then play the video again. 

 

157. To stop video time at 15 minute 58 seconds in VLC Media Player. 
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Stop video here and ask students to use the ‘Block area’ option and then play 

the video again. 

 
158. To stop video time at 16 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to highlight paragraph by using ‘Block area’ as 

shown in the video. 

Just check and then play the video again. 

 
159. To stop video time at 17 minute 01 seconds in VLC Media Player. 

 
 

Stop video here and ask students to hide and show the ‘Sidebar and then play 

the video again. 

 

 

160. To stop video time at 17 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to hide the ‘Sidebar’ as shown in the video and 

then play the video again. 

 

161. To stop video time at 18 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 
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Now just check whether they have shown in the sidebar or not then play the 

video again. 

 
162. To stop video time at 18 minute 35 seconds in VLC Media Player. 

 
Stop video here and ask students to convert their file into pdf format and then 

play the video again. 

 

163. To stop video time at 18 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shutdown the computer. 
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Complete teacher’s manual for Open office writer 3 Class 7 

Summaries 

 

 What is ‘Section’ option? 

 Why we use ‘Endnote’ and ‘Footnote’? 

 Why we use ‘Bookmark’? 

 About ‘Cross reference’ 

 What is ‘Horizontal rulers’ 

 What is ‘Text frame’ 

 Why we use ‘Text frame’ 

 Why we use ‘File option’ 

 Use of ‘Auto correct’ 

 About ‘Arrange’ 

 Why we use ‘Flip’ option? 

 What is ‘Group’ option and why we use it? 

 

 

Now let’s start video. 

 

164. To stop video time at 36 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what kind of the character you cannot 

remove or delete using the backspace and delete keys? 

Just listen to the answers and play the video again for the correct answer. 

 

165. To stop video time at 57 seconds in VLC Media Player. 

Stop video here and ask if they can tell how to remove shading from the field 

name? 
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Just listen to the answers and play the video again for the correct answer. 

 

166. To stop video time at 1 minute 22 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell in which menu you can find ‘Field 

shading’ option’? 

 Just listen to the answers and play the video again for the correct answer. 

 

167. To stop video time at 1 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with change option? 

Just listen to the answers and play the video again for the correct answer. 

168. To stop video time at 2 minute 26 seconds in VLC Media Player. 
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Stop video here and ask students to open the writer file and then play video 

again. 

 

169. To stop video time at 2 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask students to type the paragraph as shown in the video. 

Now just check whether they have one done typing or not and then play the 

video again. 

 

170. To stop video time at 2 minute 26 seconds in VLC Media Player. 
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Stop video here and ask students to use section option and then play the video 

again. 

 

171. To stop video time at 4 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

172. To stop video time at 4 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then select 

section option. 

173. To stop video time at 5 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to students to do as shown in the video and 

then play the video again. 

 

174. To stop video time at 6 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to divide the paragraph as shown in the video. 

Now just check whether they have used the section option or not then play the 

video. 

 

175. To stop video time at 6 minute 50 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is of the ‘Footnote and Endnote’? 

Just listen to the answers and play the video again for the correct answer. 

 

176. To stop video time at 8 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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177. To stop video time at 9 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Footnote’ and then play the video 

again. 

 

178. To stop video time at 11 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Endnote’ as shown in the play the 

video. 

 

179. To stop video time at 11 minute 21 seconds in VLC Media Player. 

 
Stop video here and ask students, if they can tell what happens with ‘Caption’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

180. To stop video time at 13 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to insert an object as shown in the video and 

then play the video again. 

 

181. To stop video time at 13 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert’ menu and then select 

the ‘Caption’ option as shown in the video and then play the video again. 

182. To stop video time at 15 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to give the caption as shown in the video. 

Now just check whether they have used the ‘caption’ option or not and then 

play the video again. 

183. To stop video time at 15 minute 37 seconds in VLC Media Player. 

 

184. To stop video time at 15 minute 27 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use the ‘Bookmark’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

185. To stop video time at 16 minute 01 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use the ‘Bookmark’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

186. To stop video time at 18 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph and then click on the 

‘Insert menu and then select the ‘Bookmark’ option as shown in the video and 

then play the video again. 

 

187. To stop video time at 18 minute 58 seconds in VLC Media Player. 

 Stop video here and ask students to select the paragraph and then do as shown 

in the video and then play the video again. 

 

188. To stop video time at 19 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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189. To stop video time at 20 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then select 

‘Cross reference’ and then play the video again. 

 

190. To stop video time at 20 minute 37 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

191. To stop video time at 21 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

192. To stop video time at 22 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Bookmark and Cross reference’ or not 

then play the video again. 

 

193. To stop video time at 22 minute 51 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Text frame’? 

Just listen to the answers and play the video again for the correct answer. 

 

194. To stop video time at 26 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to insert the ‘Text box’ as shown in the video 

and then play the video again. 

 

195. To stop video time at 26 minute 36 seconds in VLC Media Player. 
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Stop video here and ask students to open the hyperlink as shown in the video 

and then play the video again. 

 

196. To stop video time at 27 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

197. To stop video time at 28 minute 37 seconds in VLC Media Player. 

 Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted the ‘Text frame’ or not and then 

play the video again. 

 

198. To stop video time at 28 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to if they can make ‘envelope’? 

Just listen to the answers and play the video again for the correct answer. 

 

199. To stop video time at 29 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Menu bar’ and then click on 

the ‘Envelope’ as shown in the video and then play the video again. 

 

200. To stop video time at 32 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to type the address in the box as shown in the 

video. 

Now just check whether they have made the envelope or not and then play the 

video again. 

 

201. To stop video time at 33 minute 00 seconds in VLC Media Player. 

Stop video here and ask if they know why we use ‘Horizontal ruler’? 

Just listen to the answers and play the video again for the correct answer. 

 

202. To stop video time at 34 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to insert ‘Horizontal ruler’ as shown in the 

video and then play the video again. 

 

203. To stop video time at 35 minute 26 seconds in VLC Media Player. 
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Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted the ‘Horizontal ruler’ or not and 

then play the video again. 

 

204. To stop video time at 36 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Movie and sound’ option as shown 

in the video and then play the video again. 

 

 

 

205. To stop video time at 37 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to insert a video as shown in the video and 

then play the video again. 

 

206. To stop video time at 38 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

207. To stop video time at 38 minute 34 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘File option? 

Just listen to the answers and play the video again for the correct answer. 

208. To stop video time at 39 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then select 

the ‘File’ option as shown in the video. 

209. To stop video time at 40 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 
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Now just check whether they have inserted another file or not and then play the 

video again. 

210. To stop video time at 40 minute 23 seconds in VLC Media Player. 

 
Stop video here and ask students, if they know what happens with ‘Auto 

correct? 

Just listen to the answers and play the video again for the correct answer. 

 

211. To stop video time at 43 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

212. To stop video time at 45 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Auto correct’ option or not and then 

play the video again.  

 

213. To stop video time at 45 minute 34 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use the ‘Arrange’ option? 

Just listen to the answers and play the video again for the correct answer. 
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214. To stop video time at 46 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to insert the object as shown in the video and 

then play the video again. 

 

215. To stop video time at 47 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

216. To stop video time at 47 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

217. To stop video time at 47 minute 44 seconds in VLC Media Player. 

Stop video here and ask if they know what would happen with use of ‘Flip’? 

Just listen to the answers and play the video again for the correct answer. 

 

218. To stop video time at 48 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to insert a picture as shown in the video and 

then play the video again. 

 

219. To stop video time at 49 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to rotate the picture with the help of the ‘Flip’ 

option as shown in the video and then play the video again. 

 

220. To stop video time at 49 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they used ‘Flip’ option or not and then play the video 

again. 

 

221. To stop video time at 50 minute 02 seconds in VLC Media Player. 

Stop video here and ask if they know what happens with ‘Group’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

222. To stop video time at 51 minute 25 seconds in VLC Media Player. 
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Stop video here and ask students to draw three images as shown in the video 

and then play the video again. 

 

223. To stop video time at 51 minute 39 seconds in VLC Media Player. 

Stop video here and ask students to select all three images as shown in the video 

and then play the video again. 

 

224. To stop video time at 53 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have used ‘Group’ option or not and then play the 

video again. 

 

 

225. To stop video time at 53 minute 28 seconds in VLC Media Player. 

 
Stop video here and ask students to close their file and shout down the 

computer. 
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Complete teacher’s manual for Open office writer 3 Class 8 

Summaries 

 

 What is ‘Section’ option? 

 Why we use ‘Endnote’ and ‘Footnote’? 

 Why we use ‘Bookmark’? 

 About ‘Cross reference’? 

 What is ‘Horizontal rulers’? 

 What is ‘Text frame’? 

 Why we use ‘Text frame’? 

 Why we use ‘File option’? 

 Use of ‘Auto correct’ 

 About ‘Arrange’ 

 Why we use ‘Flip’ option? 

 What is ‘Group’ option and why we use it? 

 

Now let’s start video. 

 

226. To stop video time at 36 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Section’ option? 

Just listen to the answers and play the video again for the correct answer 

 

227. To stop video time at 1 minute 05 seconds in VLC Media Player. 
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Stop video here and ask if they can tell the difference between ‘Endnote and 

Footnote’? 

Just listen to the answers and play the video again for the correct answer. 

 

228. To stop video time at 1 minute 29 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is ‘Change’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

229. To stop video time at 1 minute 29 seconds in VLC Media Player. 

 



   

85 
 

Stop video here and ask if they know what need to do to remove shading from 

the ‘Field name’? 

Just listen to the answers and play the video again for the correct answer. 

 

230. To stop video time at 2 minute 07 seconds in VLC Media Player. 

 
Stop video here and ask, if they can tell why we use ‘Text frame’? 

Just listen to the answers and play the video again for the correct answer. 

231. To stop video time at 2 minute 31 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Horizontal ruler’? 

Just listen to the answers and play the video again for the correct answer. 

232. To stop video time at 2 minute 51 seconds in VLC Media Player. 
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Stop video here and ask students to open writer file and then play the video 

again. 

 

233. To stop video time at 2 minute 59 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given paragraph as shown in the 

video and then play the video again. 

 

234. To stop video time at 3 minute 11 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Formatting bar’ and then 

play the video again. 
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235. To stop video time at 4 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to change the font size and font color  as 

shown in the video and then play the video again. 

 

236. To stop video time at 5 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

237. To stop video time at 5 minute 58 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Formatting bar’ or not and then 

play the video again. 

 
238. To stop video time at 6 minute 09 seconds in VLC Media Player. 

 
Stop video here and ask students to divide the paragraph into two parts and 

practice the ‘Endnote and Footnote’ and then play the video again. 

 

239. To stop video time at 8 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

240. To stop video time at 11 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Footnote and Endnote’ or not and 

then play the video again. 
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241. To stop video time at 11 minute 52 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Section’ option and then play 

the video again. 

 

242. To stop video time at 12 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

243. To stop video time at 12 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert’ menu and then select 

‘Section’ option as shown in the video and then play the video again. 

 

244. To stop video time at 13 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

245. To stop video time at 13 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Section’ option or not and then 

play the video again. 

 
246. To stop video time at 14 minute 12 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Caption’ option on the other 

page and then play the video again. 

 

247. To stop video time at 14 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to draw any object as shown in video and then 

play the video again. 

 

248. To stop video time at 16 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Caption’ option or not and then 

play the video again. 

 
249. To stop video time at 16 minute 38 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Text frame’ option and also 

writer some lines about school etc… and then play the video again. 

 

 

250. To stop video time at 17 minute 23 seconds in VLC Media Player. 
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Stop video here and ask students to click on the ‘Insert’ menu and then select 

‘Text frame’ option as shown in the video and then play the video again. 

 

251. To stop video time at 19 minute 03 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

252. To stop video time at 19 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

253. To stop video time at 20 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted ‘Text frame’ option or not and then 

play the video again. 

 
254. To stop video time at 21 minute 01 seconds in VLC Media Player. 

 
Stop video here and ask students to insert ‘Horizontal ruler’ above the 

paragraph and below the paragraph and then play the video again. 

 

255. To stop video time at 21 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert’ menu and then select 

‘Horizontal ruler’ option as shown in the video and then play the video again. 

 

256. To stop video time at 22 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 
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Now just check whether they have inserted ‘Horizontal ruler’ option or not and 

then play the video again. 

 

257. To stop video time at 22 minute 40 seconds in VLC Media Player. 

 
Stop video here and ask students to insert any file by using ‘File’ option and 

then play the video again. 

 

258. To stop video time at 23 minute 39 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert’ menu and then select 

‘File’ option as shown in the video and then play the video again. 

 

259. To stop video time at 24 minute 37 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted ‘File’ option or not and then play the 

video again. 

 
260. To stop video time at 24 minute 44 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Auto correct’ option on the 

other page and then play the video again. 

 

261. To stop video time at 25 minute 37 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

262. To stop video time at 28 minute 29 seconds in VLC Media Player. 
Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Auto correct’ option or not and 

then play the video again. 

 

263. To stop video time at 28 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to any clipart and bring this to the centre of the 

text and then play the video again. 

 

264. To stop video time at 29 minute 07 seconds in VLC Media Player. 

 

Stop video here and ask students to draw three objects and practice ‘Group’ 

option and then play the video again. 

 

265. To stop video time at 29 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

266. To stop video time at 30 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format’ menu and then select 

‘Group’ option as shown in the video and then play the video again. 
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267. To stop video time at 31 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

268. To stop video time at 32 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have practiced ‘Group’ option or not and then 

play the video again. 

 

269. To stop video time at 32 minute 33 seconds in VLC Media Player. 

 

Stop video here and ask students to close their file and shutdown the computer. 
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Complete teacher’s manual for Open office writer 3 Class 9 

Summaries 

 

 What is ‘Table’? 

 Methods of drawing a Table? 

 How to insert ‘Row’ and ‘Column’? 

 What is ‘Merge cell’? 

 What is ‘Spilt cell’? 

 Why we use ‘Auto format option? 

 Why we use ‘Auto fit option? 

 Why we use ‘Convert option? 

 What is ‘Sort’ option? 

 What happens by using ‘Number format’? 

 Why we use ‘Properties option’ 

 Why we use ‘Spelling and grammar’? 

 Why we use ‘Line and numbering’? 

 

 

Now let’s start video. 

 

270. To stop video time at 24 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Section’ option? 

Just listen to the answers and play the video again for the correct answer. 
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271. To stop video time at 52 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Footnote and 

Endnote’? 

Just listen to the answers and play the video again for the correct answer. 

 

272. To stop video time at 1 minute 45 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file as shown in the video and 

then play the video again. 

 

273. To stop video time at 2 minute 50 seconds in VLC Media Player. 
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Stop video here and ask what will they learn today? 

Just listen to the answers and play the video again for the correct answer. 

 

274. To stop video time at 2 minute 57 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘Table’ and why we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

275. To stop video time at 3 minute 39 seconds in VLC Media Player. 

 
Stop video here and ask what are ‘Rows’ and ‘Columns’? 

Just listen to the answers and play the video again for the correct answer. 

 

276. To stop video time at 4 minute18 seconds in VLC Media Player. 

Stop video here and ask if they know how to insert ‘Table’? 

Just listen to the answers and play the video again for the correct answer. 

 

277. To stop video time at 5 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Insert’ menu and then click on 

‘Table’ option. 
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278. To stop video time at 5 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

279. To stop video time at 5 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to do undo as shown in the video and then play 

the video again. 

 

280. To stop video time at 6 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Table’ option of the ‘Standard 

toolbar option and then play the video again. 

 

281. To stop video time at 7 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to draw a ‘Table’ and then undo the table as 

shown in the video and then play the video again. 

 

282. To stop video time at 7 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to draw table with the help of the ‘Table 

menu’ as shown in video and then play the video again. 

 

283. To stop video time at 8 minute 02 seconds in VLC Media Player. 

 
Stop video here and ask students draw a table as shown in the video and then 

play the video again. 

 

284. To stop video time at 8 minute 24 seconds in VLC Media Player. 
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Stop video here and check whether they have drawn a table or not and then play 

the video again. 

285. To stop video time at 8 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell how to insert ‘Row’? 

Just listen to the answers and play the video again for the correct answer. 

 

286. To stop video time at 9 minute 46 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

287. To stop video time at 10 minute 59 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

 Now just check whether they have inserted row or not and then play the video 

again. 

 

288. To stop video time at 11 minute 04 seconds in VLC Media Player. 

 
Stop video here and ask if they know how to insert ‘Column’? 

Just listen to the answers and play the video again for the correct answer. 
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289. To stop video time at 12 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to insert a column as shown in the video and 

then play the video again. 

 

290. To stop video time at 13 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have inserted the table or not and then play the 

video again. 

 

291. To stop video time at 13 minute 20 seconds in VLC Media Player. 

 
Stop video here and ask students about ‘Delete’ option and then play the video 

again. 

 

292. To stop video time at 15 minute 31 seconds in VLC Media Player. 

Stop video here and ask students to delete the entire table as shown in the video. 

Now just check whether they have deleted the ‘Table’ or not and then play the 

video again. 

 

293. To stop video time at 17 minute 01 seconds in VLC Media Player. 

Stop video here and ask students to select whole table as shown in the video and 

then play the video again. 

 

294. To stop video time at 18 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to select ‘Row’ as shown in the video and then 

play the video again. 
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295. To stop video time at 19 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have selected and then play the video again. 

 
296. To stop video time at 19 minute 16 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘Merge cell’? 

Just listen to the answers and play the video again for the correct answer. 

 

297. To stop video time at 20 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to select two cells as shown in the video and 

then play the video again. 

 

298. To stop video time at 21 minute 58 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve used ‘Merge cells’ or not then play the video again. 

 

299. To stop video time at 22 minute 04 seconds in VLC Media Player. 

 



   

101 
 

Stop video here and ask if they know why we use ‘Split cell’? 

Just listen to the answers and play the video again for the correct answer. 

300. To stop video time at 23 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

301. To stop video time at 24 minute 31 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

302. To stop video time at 27 minute 38 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve used ‘Split cells’ or not then play the video again. 

 

303. To stop video time at 27minute 38 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Protect cell’? 

Just listen to the answers and play the video again for the correct answer. 

 

304. To stop video time at 28minute 14 seconds in VLC Media Player. 

Stop video here and ask students to protect a cell as shown in the video and then 

play the video again. 

 

305. To stop video time at 29 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to unprotect the cell as shown in the video. 

Just check whether they’ve used ‘Protect option’ or not then play the video 

again. 
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306. To stop video time at 29 minute 53 seconds in VLC Media Player. 

 
Stop video here and ask students to learn to use ‘Auto format’ option and then 

play the video again. 

 

307. To stop video time at 29 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Table’ menu and then click on 

‘Auto format’ option and then play the video again. 

 

308. To stop video time at 31 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

309. To stop video time at 33 minute 10 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve used ‘Auto format option’ or not then play the video 

again. 

 

310. To stop video time at 33 minute 19 seconds in VLC Media Player. 



   

103 
 

 
Stop video here and ask if they can tell why ‘Auto fit’ option is used? 

Just listen to the answers and play the video again for the correct answer. 

 

311. To stop video time at 34 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

312. To stop video time at 35 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to select the whole table as shown in the video 

and then play the video again. 

 

313. To stop video time at 35 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

314. To stop video time at 36 minute 39 seconds in VLC Media Player. 

Stop video here and ask students to select the ‘Column’ as shown in the video 

and then play the video again. 

 

315. To stop video time at 38 minute 38 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they’ve used ‘Auto fit option’ or not then play the 

video again. 

 

316. To stop video time at 38 minute 50 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what is ‘Convert option’? 

Just listen to the answers and play the video again for the correct answer. 

 

317. To stop video time at 39 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to select the entire table as shown in the video 

and then play the video again. 

 

318. To stop video time at 40 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to convert table into text as shown in the video 

and then play the video again. 

 

319. To stop video time at 41 minute 19 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

320. To stop video time at 42 minute 31 seconds in VLC Media Player. 

Stop video here and ask students to convert ‘Text’ into ‘Table’ as shown in the 

video. 

Just check whether they’ve used ‘Convert option’ or not then play the video 

again. 

 

321. To stop video time at 42 minute 51 seconds in VLC Media Player. 
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Stop video here and ask them, why we use ‘Formula option’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

322. To stop video time at 44 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to Sum up the number by applying ‘Sum’ 

formula as shown in the video and then play the video again. 

 

 

323. To stop video time at 45 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

324. To stop video time at 47 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

325. To stop video time at 49 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to insert one more ‘Column’ and type 

difference in this column as shown in the video and then play the video again. 

 

326. To stop video time at 49 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to subtract two numbers as shown in the video 

and then play the video again. 

 

327. To stop video time at 50 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to multiply two numbers as shown in the video 

and then play the video again. 
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328. To stop video time at 50 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve used ‘Formula option’ or not then play the video 

again. 

 

329. To stop video time at 51 minute 03 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Number format’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

330. To stop video time at 51 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Table’ menu and then click on 

‘Number format’ option and then play the video again. 

 

331. To stop video time at 53 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

332. To stop video time at 53 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve used ‘Number format option’ or not then play the 

video again. 

 

333. To stop video time at 54 minute 00 seconds in VLC Media Player. 
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Stop video here and ask why we use ‘Table properties’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

334. To stop video time at 55 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Table’ menu and then click on 

‘Table properties’ option and then play the video again. 

 

335. To stop video time at 56 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

336. To stop video time at 58 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

337. To stop video time at 59 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to change the width of ‘Column’ as shown in 

the video and then play the video again. 

 

338. To stop video time at 1 Hour 02 minute 07 seconds in VLC Media 

Player. 

Stop video here and ask students to do bring the normal table with help of 

‘Undo’ as shown in the video and then play the video again. 

 

339. To stop video time at 1 Hour 03 minute 07 seconds in VLC Media 

Player. 
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Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

340. To stop video time at 1 Hour 05 minute 46 seconds in VLC Media 

Player. 

Stop video here and ask students to change the background color of the table as 

shown in the video and then play the video again. 

 

341. To stop video time at 1 Hour 06 minute 20 seconds in VLC Media 

Player. 

Stop video here and ask students to draw another ‘Table’ as shown in the video 

and then play the video again. 

 

342. To stop video time at 1 Hour 07 minute 46 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve used ‘Table properties option’ or not then play the 

video again. 

 

343. To stop video time at 1 Hour 05 minute 23 seconds in VLC Media 

Player. 

 
Stop video here and ask students to use ‘Spelling and Grammar’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

344. To stop video time at 1 Hour 08 minute 00 seconds in VLC Media 

Player. 
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Stop video here and ask students to do spelling check as shown in the video and 

then play the video again. 

 

345. To stop video time at 1 Hour 09 minute 53 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve checked spelling or not then play the video again. 

 

346. To stop video time at 1 Hour 11 minute 55 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

347. To stop video time at 1 Hour 13 minute 39 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve used ‘Language option’ or not then play the video 

again. 

 

 

 

 

 

 

 

 

348. To stop video time at 1 Hour 13 minute 45 seconds in VLC Media 

Player. 
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Stop video here and ask if they can what is ‘Line and numbering? 

Just listen to the answers and play the video again for the correct answer. 

 

349. To stop video time at 1 Hour 14 minute 29 seconds in VLC Media 

Player. 

Stop video here and ask students to click on ‘Tools’ menu and then click on 

‘Line and numbering’ option and then play the video again. 

 

350. To stop video time at 1 Hour 15 minute 48 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

351. To stop video time at 1 Hour 17 minute 58 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

Just check whether they’ve used ‘Line and numbering option’ or not then play 

the video again. 

 

352. To stop video time at 1 Hour 18 minute 13 seconds in VLC Media 

Player. 
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Stop video here and ask students to close their file and shutdown the computer. 
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Complete teacher’s manual for Open office writer 3 Class 10 

Summaries 

 

 What is a ‘Table’? 

 There are how many methods of drawing a Table? 

 How to insert ‘Row’ and ‘Column’? 

 What is ‘Merge cell’? 

 What is ‘Spilt cell’? 

 Why we use ‘Auto format option? 

 Why we use ‘Auto fit option? 

 Why we use ‘Convert option? 

 What is ‘Sort’ option? 

 What happens by using ‘Number format’? 

 Why we use ‘Properties option’ 

 Why we use ‘Mail merge’ 

 What is ‘Macro’ 

 How to customize menus and tools? 

Now let’s start video. 

 

353. To stop video time at 46 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Section’ option? 

Just listen to the answers and play the video again for the correct answer. 
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354. To stop video time at 1 minute 17 seconds in VLC Media Player. 

 
Stop video here and ask what is ‘Table’ and why we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

355. To stop video time at 1 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘Merge cell’? 

Just listen to the answers and play the video again for the correct answer. 

 

356. To stop video time at 2 minute 14 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘Split cell’? 

Just listen to the answers and play the video again for the correct answer. 

 

357. To stop video time at 2 minute 39 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Protect cell’? 

Just listen to the answers and play the video again for the correct answer. 

 

358. To stop video time at 2 minute 56 seconds in VLC Media Player. 

 
Stop video here and ask how to unprotect the protected ‘Cell’? 

Just listen to the answers and play the video again for the correct answer. 
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359. To stop video time at 3 minute 18 seconds in VLC Media Player. 

 
Stop video here and ask them, if they know what happens with use of ‘Formula 

option’? 

Just listen to the answers and play the video again for the correct answer. 

 

360. To stop video time at 3 minute 41 seconds in VLC Media Player. 

 
Stop video here and ask them to open writer file and then play the video again. 

 

361. To stop video time at 4 minute 03 seconds in VLC Media Player. 

Stop video and ask students to draw a table.  

Now check whether they’ve drawn ‘Table’ or not then play the video again. 

 

362. To stop video time at 4 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to insert a row as told in video and then play 

the video again. 

 

363. To stop video time at 5 minute 44 seconds in VLC Media Player. 

Now check whether they’ve inserted ‘Row’ or not then play the video again. 
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364. To stop video time at 5 minute 51 seconds in VLC Media Player. 

 
Stop video here and ask students to insert a ‘Column’ as told in video and then 

play the video again. 

 

365. To stop video time at 7 minute 46 seconds in VLC Media Player. 

Now check whether they’ve inserted ‘Column’ or not then play the video again. 

 

366. To stop video time at 7 minute 57 seconds in VLC Media Player. 

 
Stop video here and ask students to ‘Split’ the ‘price’ ‘Cell’ into into ‘Rs’ and 

‘paisa’ and then play the video again. 

 

367. To stop video time at 8 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

368. To stop video time at 10 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now check whether they’ve spilt the ‘Cell’ or not then play the video again. 
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369. To stop video time at 10 minute 54 seconds in VLC Media Player. 

 
Stop video here and ask students to combine the ‘Cells’ and then play the video 

again. 

 

To stop video time at 11 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

370. To stop video time at 11 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

371. To stop video time at 13 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now check whether they’ve combined the ‘Cells’ or not then play the video 

again. 

 

372. To stop video time at 13 minute 40 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Sort’ option and then play 

the video again. 

 

373. To stop video time at 13 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to arrange the data in ascending order and 

descending order and then play the video again. 

   

374. To stop video time at 14 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Table’ menu and then click on 

‘Sort’ option and then play the video again. 

 

375. To stop video time at 15 minute 03 seconds in VLC Media Player. 

Stop video here and ask students to change the Data in ascending order. 

 Now just check whether they have used the ‘Sort’ option or not and then play 

the video again. 

 

376. To stop video time at 15 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to increase the size of ‘Row and Column’ and 

then play the video again. 

 

377. To stop video time at 16 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Table’ menu and then click on 

‘Auto fit’ option and then play the video again. 

 

378. To stop video time at 16 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

379. To stop video time at 17 minute 28 seconds in VLC Media Player. 

Now check whether they’ve increased and decreased size of ‘Row’ and 

‘Column’ or not then play the video again. 

 

380. To stop video time at 18 minute 22 seconds in VLC Media Player. 
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Stop video here and ask students to sum up the number and then play the video 

again. 

 

 

381. To stop video time at 18 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to insert a row and do as shown in the video 

and then play the video again. 

 

382. To stop video time at 20 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now check whether they’ve added the numbers or not then play the video again. 

 

383. To stop video time at 20 minute 23 seconds in VLC Media Player. 

 
Stop video here and ask students to convert the table into text and then play the 

video again. 

 

384. To stop video time at 21 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Table’ menu and then click on  

‘Convert’ option and then play the video again. 
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385. To stop video time at 21 minute 58 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now check whether they’ve converted the table into text or not then play the 

video again. 

 

 

386. To stop video time at 22 minute 11 seconds in VLC Media Player. 

 
Stop video here and ask what happens with ‘Mail merge’? 

Just listen to the answers and play the video again for the correct answer. 

 

387. To stop video time at 23 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then click on 

the ‘Mail merge’ as shown in the video and then play the video again. 

 

388. To stop video time at 24 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

389. To stop video time at 26 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to type the address line as shown in video and 

save the address and then play the video again. 

 

390. To stop video time at 27 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 
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391. To stop video time at 30 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now check whether they’ve used the ‘Mail merge’ option or not then play the 

video again. 

 

 

 

392. To stop video time at 30 minute 31 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is ‘Macro’? 

Just listen to the answers and play the video again for the correct answer. 

 

393. To stop video time at 31 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Tools’ menu and then click on 

‘Macro’ and then ‘Record Marco’ option and then play the video again. 

 

394. To stop video time at 32 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to type some lines and then save it as shown in 

the video and then play the video again. 

 

395. To stop video time at 33 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to ‘Run’ the ‘Macro’ as shown in the video. 

Now just check and then play the video again. 

 

396. To stop video time at 34 minute 00 seconds in VLC Media Player. 
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Stop video here and ask if they know what happens with ‘Customize’? 

Just listen to the answers and play the video again for the correct answer. 

 

397. To stop video time at 34 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Tools’ menu and then click on 

‘Customize’option and then play the video again. 

 

398. To stop video time at 36 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

399. To stop video time at 37 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

400. To stop video time at 38 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

401. To stop video time at 40 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

402. To stop video time at 40 minute 37 seconds in VLC Media Player. 
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Stop video here and ask students to close their file and shutdown the computer. 
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Complete teacher’s manual for Open office writer 3 Class 11 

Summaries 

 

 Why we use ‘Section’ option? 

 How to create ‘Hyperlink’ with help of ‘Section’ option? 

 How to remove shading from the “Field name’? 

 Use of ‘Footnote and Endnote’. 

 About formatting option. 

 Why we use ‘Find and replace’? 

 About match case. 

 Why we ‘Customize’ option? 

 What are the Non-printing characters? 

 What is ‘Macro’? 

 How to run ‘Macro’? 

 

Now let’s start video. 

 

403. To stop video time at 44 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Macro’? 

Just listen to the answers and play the video again for the correct answer. 
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404. To stop video time at 01 minute 03 seconds in VLC Media Player. 

 
Stop video here and ask if they know what happens with ‘Customize’? 

Just listen to the answers and play the video again for the correct answer. 

 

405. To stop video time at 01 minute 32 seconds in VLC Media Player. 

 
Stop video here and ask which characters are not deleted by ‘Backspace’ or 

‘Delete’ button 

Just listen to the answers and play the video again for the correct answer.  

 

406. To stop video time at 01 minute 53 seconds in VLC Media Player. 
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Stop video here and ask what they will do to remove the shading from the ‘Field 

name’ 

Just listen to the answers and play the video again for the correct answer. 

 

407. To stop video time at 02 minute 20 seconds in VLC Media Player. 

 
Stop video here and ask what is the difference between ‘Standard area and 

‘Block area? 

Just listen to the answers and play the video again for the correct answer. 

 

408. To stop video time at 02 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell ‘what happens with the ‘Auto correct’? 

 Just listen to the answers and play the video again for the correct answer. 
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409. To stop video time at 03 minute 04 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell how to hide ‘Standard toolbar’? 

Just listen to the answers and play the video again for the correct answer. 

 

410. Stop video time at 03 minute 31 seconds in VLC Media Player. 

 
Stop video here and ask if they know what is ‘Navigator’? 

Just listen to the answers and play the video again for the correct answer. 

 

411. To stop video time at 04 minute 12 seconds in VLC Media Player. 
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Stop video here and ask students to open the ‘Writer’ file and then play the 

video again. 

412. To stop video time at 04 minute 18 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given paragraph and also ask them 

to do formatting as shown in the video and then play the video again. 

 

413. To stop video time at 04 minute 27 seconds in VLC Media Player. 

 
Stop video here and ask students to do the formatting on the paragraph as shown 

in the video and then play the video again. 

 

414. To stop video time at 05 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph and change the size of 

the font as shown in the video and then play the video again. 

 

415. To stop video time at 07 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to apply ‘Bullets on the paragraph and also ask 

to change background color of line as shown in the video. 

Now just check whether they have done the formatting or not and then  play the 

video again. 



   

129 
 

 

 

416. To stop video time at 07 minute 51 seconds in VLC Media Player. 

 
Stop video here and ask students to divide the paragraph in two parts with help 

of ‘Section’ option and then play the video again. 

 

417. To stop video time at 08 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Insert’ menu and then click on 

‘Section’ option and then play the video again. 

 

418. To stop video time at 10 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

419. To stop video time at 11 minute 31 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

420. To stop video time at 11 minute 48 seconds in VLC Media Player. 
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Stop video here and ask students to insert ‘Text frame’ and also type few lines 

on it and then change the background color in it, after that attach the hyperlink 

on it and then play the video again.  

 

421. To stop video time at 12 minute 15 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Insert’ menu and then click on 

‘Frame’ option and then play the video again. 

 

422. To stop video time at 14 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

423. To stop video time at 16 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

424. To stop video time at 17 minute 37 seconds in VLC Media Player. 

Stop video here and ask students to type a line in ‘Text frame’ as shown in the 

video and then play the video again. 

Stop video here and ask students to practice ‘Text frame’ option or not and then 

play the video again. 

 

425. To stop video time at 17 minute 47 seconds in VLC Media Player. 

 
Stop video here and ask students to insert ‘Endnote and Footnote and then play 

the video again. 

 

426. To stop video time at 18 minute 20 seconds in VLC Media Player. 
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Stop video here and ask students to take a new page as shown in the video and 

then play the video again. 

 

 

427. To stop video time at 18 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then select as 

shown in the video and then play the video again. 

 

428. To stop video time at 19 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

429. To stop video time at 21 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now check whether they’ve practiced ‘Footnote and Endnote’ option or not and 

then play the video again. 

 

430. To stop video time at 21 minute 06 seconds in VLC Media Player. 

 
Stop video here and ask how to record ‘Macro’? 

Just listen to the answers and play the video again for the correct answer. 

 

431. To stop video time at 22 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Tools’ menu and then click on 

‘Macrorecord’ option and then play the video again. 

 

432. To stop video time at 23 minute 14 seconds in VLC Media Player. 
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Stop video here and ask students to record the message and then save it as 

shown in the video and then play the video again. 

 

 

 

433. To stop video time at 23 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to insert the new page as shown in the video 

and then play the video again. 

 

434. To stop video time at 24 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check whether they have recorded the ‘Macro’ or not and then play 

the video again. 

 
435. To stop video time at 24 minute 35 seconds in VLC Media Player. 

 
Stop video here and ask students to practice ‘Find and replace’ option and then 

play the video again. 

 

436. To stop video time at 24 minute 58 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Edit’ menu and then click on ‘Find 

and replace’ option and then play the video again. 

 

437. To stop video time at 25 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to find ‘there’ word as shown in the video and 

then play the video again. 

 

438. To stop video time at 26 minute 53 seconds in VLC Media Player. 
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Stop video here and ask students to change the ‘There’ word into ‘Here’ word 

as shown in the video. 

Now just check and then play the video again. 

 

 

439. To stop video time at 27 minute 06 seconds in VLC Media Player. 

 
Stop video here and ask students to do text wise formatting and then play the 

video again. 

 

440. To stop video time at 28 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

441. To stop video time at 28 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video. 

Now just check and then play the video again. 

 

442. To stop video time at 29 minute 07 seconds in VLC Media Player. 

 
Stop video here and ask students to save their file and shutdown the computer. 


